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Quick Start to 3ds Max and
3ds Max Design Installation

This section provides quick start instructions on how to install your product on your system.
You should read the entire Autodesk 3ds Max 2010 and Autodesk 3ds Max Design 2010 Installation
Guide if you have any questions that are not addressed in this Quick Start section.

This installation guide applies to both products.

NOTE For differences between Autodesk 3ds Max and Autodesk 3ds Max Design, see
Differences Between 3ds Max and 3ds Max Design on page 5.

For network installs, you can also install your product by deploying the program. This can
be especially useful when you want to install your product on many machines on a network.
To deploy your product, see the Autodesk 3ds Max 2010 and Autodesk 3ds Max Design 2010
Network Administrator’s Guide, which you can access from the Documentation link in your
product Installation Wizard.

NOTE Throughout this guide the term "your product" is used to refer to either Autodesk
3ds Max 2010 or Autodesk 3ds Max Design 2010.

How to Use this Document
This document is divided into four chapters. Read the chapter descriptions to
see which ones contain information that pertains to your situation.

■ See Quick Start to 3ds Max and 3ds Max Design Installation on page 1 for
a quick overview of the install process. If your install is straightforward, this
may be sufficient information.

1
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■ See Installing Your Product on page 5 for a detailed explanation of how
to install, start, and license Autodesk 3ds Max 2010 and Autodesk 3ds Max
Design 2010. Also find out about customizing your installation.

■ See Supplemental Tools and Utilities on page 47 for an explanation of the
various supplementary tools that you may wish to install.

■ See Installation Troubleshooting on page 63 if you have any problems or
questions during your installation.

Preparing for Installation
Before you install 3ds Max or 3ds Max Design, you need to perform a few
tasks. These steps are briefly outlined in this chapter or described in more
detail in Installing Your Product on page 5.

Verifying System Requirements
Before you install your product, make sure that your computer meets the
system requirements. If your system does not meet the system requirements,
problems can occur, both within 3ds Max or 3ds Max Design and at the
operating system level.

To review the system requirements, see System Requirements on page 6.

Obtaining Administrative Permissions
To install 3ds Max or 3ds Max Design, you must have administrator
permissions. See Administrative Permission Requirements on page 12 for
complete details.

Closing Other Programs
Certain other programs may cause problems during the 3ds Max or 3ds Max
Design installation. It is suggested that you close these programs. See Closing
Other Programs During Installation on page 2 for a complete list of these
programs.

2 | Chapter 1   Quick Start to 3ds Max and 3ds Max Design Installation



Installing and Running Your Product
To use the product, you must install the product, then launch it. To run it
beyond the 30-day trial period, you must register and activate it.

Installing 3ds Max or 3ds Max Design
1 Insert the Software DVD into your computer's drive.

2 In the 3ds Max or 3ds Max Design Installation Wizard, click Install
Products.

3 Follow the directions on each installation page.

For detailed instructions on installing 3ds Max or 3ds Max Design, see Installing
Your Product on page 5.

3ds Max or 3ds Max Design Serial Number and Product
Key Overview

To activate your product, you will need the serial number and product key
found on the outside of the DVD case (or in the purchase confirmation email
you received if you purchased your product or upgrade online). See Locating
Your Serial Number and Product Key on page 3 for more information,
including for Autodesk store (online store) downloads.

Registering and Activating 3ds Max or 3ds Max Design
After your product is installed, you can initiate the registration process by
launching the product. When you launch your product, the Product Activation
wizard is displayed. Follow the directions in the Product Activation wizard to
register the product.

NOTE If you are upgrading from an earlier release, use your new serial number
and product key when you register and activate the new release.

For detailed instructions on registering 3ds Max or 3ds Max Design, see
Registering and Activating Your Product on page 27.
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Starting 3ds Max or 3ds Max Design
You can start your product from a desktop shortcut, the Start menu, or from
the location where you installed your product (with administrator permissions).
See Starting Your Product on page 24 for further details.

Learning About New Features
For more information about the new features, see the “What’s New” section
in the 3ds Max Help or the 3ds Max Design Help (accessible from the Help menu
in the corresponding product).

Additional Information on the Web
Several pages on the Autodesk web site provide additional information about
3ds Max and 3ds Max Design.

3ds Max Web Sites
■ http://www.autodesk.com/3dsmax for product information and related links.

■ http://www.autodesk.com/3dsmax-learningpath for a map to online learning
resources such as tutorials, videos, and help.

■ http://www.autodesk.com/3dsmax-support for support.

3ds Max Design Web Sites
■ http://www.autodesk.com/3dsmaxdesign for product information and related

links.

■ http://www.autodesk.com/3dsmaxdesign-learningpath for a map to online
learning resources such as tutorials, videos, and help.

■ http://www.autodesk.com/3dsmaxdesign-support for support.
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Installing Your Product

This section provides detailed instructions for installing and activating 3ds Max or 3ds Max
Design for an individual user. For information about installing network-licensed or multi-seat
standalone-licensed versions of the program, see the Autodesk 3ds Max 2010 and Autodesk 3ds
Max Design 2010 Network Administrator's Guide, located on the Documentation tab of the
Installation Wizard.

Differences Between 3ds Max and 3ds Max Design
Though this guide is shared between 3ds Max and 3ds Max Design, there are a
some key differences between these two products—as 3ds Max Design is intended
for architecture and visualization customers, the tutorials and movies that are
included show typical applications and scenarios for these customers. In
addition, 3ds Max Design contains Exposure™ lighting analysis technology,
which is designed specifically for architecture and visualization work flows. To
learn more about Exposure lighting analysis, refer to the 3ds Max Design Help.

The tutorials and movies included with 3ds Max demonstrate 3D pipelines
typically employed by artists and animators in films, games and television-related
fields. In addition, 3ds Max ships with the SDK which can be used to add your
own plug-ins to your 3ds Max pipeline. The only difference that you will notice
during the install procedure is that you cannot install the SDK with 3ds Max
Design.

It is possible to install both 3ds Max and 3ds Max Design on the same
machine—a unique serial number and product key for each product is required
to activate the software so that you can run the products beyond the 30-day
trial period.

2
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System Requirements
Before you begin the install process, make sure your system meets the
minimum software and hardware operating requirements for Autodesk 3ds
Max 2010 or Autodesk 3ds Max Design 2010.

Operating Systems
The supported operating systems depend on whether you are running the 32-
or 64-bit version of your product.

NOTE The same system requirements are shared between 3ds Max 2010 and 3ds
Max Design 2010.

32-Bit Version
The following are the supported operating systems for the 32-bit version of
3ds Max 2010 and 3ds Max Design 2010.

■ Microsoft® Windows® Vista™ (Business, Premium and Ultimate)

■ Microsoft® Windows® XP Professional (Service Pack 2 or higher)

■ NOTE  Windows 2003 (Server), Windows® XP Home Edition, Windows®

2000 or earlier releases are not supported operating systems.

64-Bit Version
The following are the supported operating systems for the 64-bit version of
3ds Max 2010 and 3ds Max Design 2010.

■ Microsoft® Windows® Vista™ (Business, Premium and Ultimate)

■ Microsoft® Windows® XP Professional x64, which is the recommended 64-bit
operating system.
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Hardware Requirements
Certain hardware requirements apply to both the 32- and 64-bit versions of
3ds Max 2010 or 3ds Max Design 2010, while others apply to only one or the
other.

32-Bit Version
The 32-bit version of 3ds Max 2010 and 3ds Max Design 2010 requires the
following hardware:

Minimum Requirements:Hardware Item:

Processor ■ Intel Pentium® 4 or higher, AMD Athlon® 64 or higher, or
AMD Opteron® processor

Hard Disk ■ 1 GB of swap space but 2 GB is recommended.

RAM ■ 1 GB RAM but 2GB is recommended

NOTE The complexity of your scene impacts the amount of
RAM you need to maintain performance.

64-Bit Version
The 64-bit version of 3ds Max 2010 and 3ds Max Design 2010 requires the
following hardware:

Minimum Requirements:Hardware Item:

Processor ■ Intel® EM64T, AMD® Athlon® 64 or AMD Opteron® pro-
cessor

Hard Disk ■ 1 GB of swap space but 2 GB is recommended.

RAM ■ 1 GB RAM but 4 GB is recommended
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Minimum Requirements:Hardware Item:

NOTE The complexity of your scene impacts the amount of
RAM you need to maintain performance.

Shared Hardware Requirements (32- and 64-Bit)
Both 32- and 64-bit machines require the following hardware.

Minimum Requirements:Hardware Item:

Display Minimum ■ Graphics cards that support a minimum resolution of 1024
x 768 x 16-bit color.

Hardware Accelera-
tion

■ Hardware-accelerated OpenGL® and Direct3D with a resol-
ution set to 1280 x 1024 x 32-bit color (or higher) is both
supported and recommended. OpenGL and Direct3D®

hardware acceleration is supported with graphics cards
having a minimum of 128 MB of memory.

■ Some features of your product are only enabled when used
with graphics hardware that supports Shader Model 3.0
(Pixel Shader and Vertex Shader 3.0). Check with your
manufacturer to determine whether your hardware supports
this.

NOTE 256-color mode is not supported.

Mouse/Tablet with
Pen

■ Microsoft® Windows®-compliant pointing device (optimized
for Microsoft® IntelliMouse®)

DVD-ROM drive ■ DVD-ROM drive to launch the your product Installation
DVD.

Network ■ A TCP/IP-configured network is required for use in network
rendering, is needed to access the internet for tasks such
as downloading support installs, and is needed for network
licensed setups.
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Minimum Requirements:Hardware Item:

Sound card and
speakers (Optional)

■ Required for listening to audio tracks.

Software Requirements
Certain softwares are required while others are optional.

Software Require-
ments

Internet Explorer® 6
(or later)

■ To activate and register your product and to view the help,
you must have Internet Explorer® 6 (or later). You can
download Internet Explorer from the Microsoft Web site:
http://www.microsoft.com/windows/ie/

DirectX® Updates ■ Both DirectX 9.0c and DirectX 10 (Vista only) are supported.

■ For DirectX 9.0c you must at least have the original version
of DirectX 9.0c from Microsoft. If you have Windows XP
SP2, you should already have it installed.

■ For DirectX 10 you must have DirectX 10 and all of the
updates from Microsoft. If you are running Windows Vista,
you should already have these items installed.

■ When you install your product, a specific set of Direct 3D
updates is installed for DirectX 9.0c (August 2008, June
2007, December 2006, and October 2006) and for DirectX
10 (August 2008, June 2007 and December 2006). These
updates make it possible for DirectX to work with your
product.

■ You can download the latest version of DirectX (for DirectX
9.0c or 10) from http://www.microsoft.com/DirectX. Choose
either the For Gamers or For Pros link and then click Down-
load the Latest DirectX.

Acrobat® Reader® 8 ■ You will need Acrobat Reader to view all of the PDF docu-
ments on your Software DVD.
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Software Require-
ments

■ If you do not have Acrobat® Reader® installed, you can go
to the Adobe Web Site at http://www.adobe.com/products/ac-
robat/readstep2.html

Adobe® Flash Player ■ Adobe® Flash Player is required to view the Hot Key Map
(available from the Help menu).

■ If you do not have Adobe® Flash Player installed, you can
go to the Adobe Web Site at ht-
tp://www.adobe.com/products/flashplayer/

Optional Software

OpenGL® ■ If your graphics card supports OpenGL you will need to
install the OpenGL driver that comes with your card. For
more information see http://www.opengl.org.

Java Runtime Environ-
ment Download

■ You will need this download to use the JSR Viewer (M3G
Player) which you access from Programs > Autodesk >
Autodesk 3ds Max 2009 > JSR Viewer.

32- or 64-bit Support
When you install 3ds Max or 3ds Max Design the installer detects whether
your machine is 32- or 64-bit. On a 64-bit machine with a 64-bit operating
system you have the option of installing either the 32- or 64-bit version (as
well as installing both of them on the same machine, and running them both
together at the same time). The following illustration summarizes the various
combinations of 3ds Max and 3ds Max Design available.

NOTE You can deploy your product from a 32-bit machine to both 32- and 64-bit
machines. See your Network Administrator’s Guide for complete details on deploying
over a network.
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Calculating the Appropriate Swap-File Setting
A good rule to keep in mind for configuring the size of your Windows swap-file
is to have three times the amount of physical memory (RAM) on your system.
Depending on scene complexity, more swap space might be desirable. When
you output to high-resolution film or print work, the demands will be much
higher than for video resolutions. This is especially true when using Image
Motion Blur.

Many users dedicate entire hard drives or partitions as swap-files. Setting
swap-files in this manner avoids any fragmentation of the swap-file.

It is very important that you have sufficient swap space set aside. A common
cause of system instability is an improperly sized swap-file.

The Installation DVDs
Your product ships on two DVDs. The product DVD contains:

■ the main software install

■ required installs (supporting utilities)

■ optional installs (third-party plugins and tutorial files)
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The second DVD contains:

■ a library of sample files that can be used as assets

Administrative Permission Requirements
To install your product, you must have administrator permissions. You do
not need to have domain administrative permissions. See your system
administrator for information about administrative permissions.

You will need these permissions to:

■ Activate your product.

■ Install your product or any of its components.

■ Install network-rendering services.

■ Remove your product or any of its components.

■ Import and export your product license with the Portable License Utility.

To run your product, you do not need administrator permissions. You can
run the program as a limited-rights user.

Locating Your Serial Number and Product Key
Your serial number and product key are located on the outside of the product
package. When you are activating your product, you are prompted for this
information. Make sure to have these numbers available for activation. Record
the serial number and key and keep them on hand.

NOTE The serial number and product key will also be required for your next
upgrade, if you ever have to reinstall or reactivate the software, or if you need to
contact support.

Serial Number and Product Key for the Autodesk Store
Download

If you purchased the electronic version of your product from the Autodesk
Store (online store), you find your serial number and product key in both the
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“Thank You for Purchasing Autodesk 3ds Max 2010 or Autodesk 3ds Max
Design 2010” e-mail and the follow-up e-mail.

Closing Other Programs During Installation
The installation process may stop if some applications (such as Microsoft®

Outlook® or virus-checking programs) are running. Close all running
applications to avoid possible data loss.

Additionally, ensure that none of the following programs are running:
Autodesk® 3ds Max®, Autodesk® 3ds Max® Design, AutoCAD®, Autodesk®

Combustion®, or Autodesk® VIZ.

The Installation Wizard
The Installation Wizard contains all installation-related material in one place.
From the Installation Wizard, you can also access user documentation and
view support solutions.

NOTE The screenshots shown throughout the guide are taken from the Autodesk
3ds Max 2010 Installation Wizard except where significant differences exist with
Autodesk 3ds Max Design 2010.

A Quick Installation Wizard Tour
When you insert the Software DVD in your drive you will see this main installer
page:
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NOTE  If Autorun does not start the Installation Wizard, navigate to your
DVD-ROM. Click the Setup.exe file to open the Installation Wizard.

The Main Installation Wizard Menu

The Main Installation Wizard menu has four options:

■ Install Products—Click to install your product. Certain required software
such as Autodesk Backburner are also installed from this section.

■ Create Deployments—Click to create an administrative image of your
product which will be deployed to multiple workstations. You do not need
to visit this section if you are simply installing your product on a single
machine. Generally, these administrative images are created by a system
administrator. Before creating the image, read the Autodesk® 3ds Max®

2010 and Autodesk® 3ds Max® Design 2010 Network Administrator's Guide
to learn about deploying your product.
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■ Install Tools and Utilities—Click to install available supplementary, optional
softwares. For details on these tools and utilities see Supplemental Tools
and Utilities on page 47.

■ Read the Documentation—Click to access the install documentation.

Documentation and Support
Documentation and Support links are located in the bottom-left corner of the
Installation Wizard. As noted above, you can also access Documentation from
the main menu of the Installation Wizard.

Install and Help File Documentation Set
You can view the entire install documentation set from the Read the
Documentation button in the main menu or from the Documentation link
in the bottom left corner of all tabs in the Installation Wizard. You also have
access to these documents on the Software DVD in the \Docs folder.

NOTE The install documentation set is not installed with your product.

It is recommended that you read the 3ds_Max_readme.rtf and this installation
guide before beginning the install.

The following table summarizes the install documentation set for Autodesk
3ds Max 2010 and Autodesk 3ds Max Design 2010:

For Information About:File NameName of Document

Late-breaking information
related to this version of

3ds_Max_readme.rtfAutodesk 3ds Max 2010
or Autodesk 3ds Max
Design 2010 Readme Autodesk 3ds Max 2010 or

Autodesk 3ds Max Design
2010.

Installing 3ds Max 2010 and
3ds Max Design 2010.

3ds_Max_sig.pdfAutodesk® 3ds Max®

2010 and Autodesk® 3ds
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For Information About:File NameName of Document

Max® Design 2010 Install-
ation Guide

How to create an administrat-
ive image and distribute it to
multiple users.

adsk_nag_3ds_Max.pdfAutodesk® 3ds Max®

2010 and Autodesk® 3ds
Max® Design 2010 Net-
work Administrator's
Guide

Setting up standalone li-
censes.

adsk_slg.pdfStand-Alone Licensing
Guide

Setting up network licenses,
including FLEXlm licensing.

adsk_nlg.pdfNetwork Licensing Guide

Advanced User Guide for
Network Licensing Adminis-
tration.

LicensingEndUser-
Guide.pdf

FLEXnet Licensing Guide

Procedures for license borrow-
ing.

adsk_brw.pdfLicense Borrowing Guide

SAMReport-lite which is a re-
porting tool that helps you
track network license usage.

Samlite_ug.pdfSAMReport-lite™ User’s
Guide

A full set of help files is also included with your product. Typically you access
these files through the Help menu in your product. You also have access to
the help files from the Start menu. (Start > Programs > Autodesk > Autodesk
3ds Max [Design] 2010 [32- or 64-bit] > Help

For a description of all of the documents related to 3ds Max and 3ds Max
Design see the “Documentation Set” topic in the Help available from the Help
menu in your product.

Installing Your Product
This section contains information for installing your product on a single
workstation. You must have administrative permissions to install your product.
During your installation you will either select Standalone or Network License,
depending on the type of license you purchased.
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To perform a default install:

1 Insert the Software DVD.

NOTE  If Autorun does not start the Installation Wizard, navigate to your
DVD-ROM. Click the Setup.exe file to open the Installation Wizard.

2 Click Install Products on the Main Menu.

NOTE Click Read the Documentation if you want to access the install
documentation set.

3 On the Select Products to Install page the entries that apply to your
operating system (32- or 64-bit) are selected for install. For a 32-bit OS
only the 32-bit options are selected by default whereas for a 64-bit OS,
all options, including 32-bit options are selected. If you have already
installed any of the components listed, these items will not be marked
for install.

NOTE To install 3ds Max or 3ds Max Design only, you must turn off all items.
It is then possible to select 3ds Max or 3ds Max Design only.
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The following items are selected for install by default:

■ Autodesk 3ds Max 2010/Autodesk 3ds Max Design 2010 [32- or 64-bit]

■ Autodesk 3ds Max 2010/Autodesk 3ds Max Design 2010 [32- or 64-bit]
Components

■ Backburner 2008.1.1 [32-bit which is 64-bit compatible]

■ Autodesk 3ds Max 2010/Autodesk 3ds Max Design 2010 [32- or64-bit]
Tutorial Files

If you do not want to install a certain product, uncheck the corresponding
option. Notice that Autodesk Backburner 2008.1.1 must be installed with
3ds Max or 3ds Max Design.

Click Next to continue.

4 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.
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NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.

5 On the Product and User Information page enter your details.

NOTE Be precise because you will not be able to change this information
once you begin the install, unless you uninstall and reinstall 3ds Max or 3ds
Max Design.

6 On the Review - Configure - Install page you can proceed with the default
install by clicking Install. This means that the default values of 3ds Max
Standalone License, default location, and Mental Ray Satellite Port on
7511 (32-bit machines) or 7512 (64-bit machines) are selected OR 3ds
Max Design Standalone License, default location, and Mental Ray Satellite
Port on 7513 (32-bit machines) or 7514 (64-bit machines).

To make custom selections, go to the next procedure.

NOTE For more information about custom installations, see Components
(Optional Tools) on page 49.
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To specify custom install options:

1 With Autodesk 3ds Max 2010 or Autodesk 3ds Max Design 2010 selected
on the Review - Configure - Install page, click Configure.

2 You now have a tab for each of aspect of the installation that has
non-default options.

3 On the Autodesk 3ds Max or Autodesk 3ds Max Design tab you can set
the license type to:

Standalone License—See Standalone Licenses (Regular and Multi-Seat)
on page 32.

Network License—See Network Licenses on page 36.

■ For Autodesk 3ds Max or Autodesk 3ds Max Design, on the Mental
Ray Satellite tab you can change the Satellite TCP port used for mental
ray rendering. Before changing this option, please see mental ray
Satellites on page 22 below. Click Next when you are finished.

4 On the Autodesk 3ds Max or Autodesk 3ds Max Design Components tabs,
you can exclude components from the installation. To learn more about
the components, see Components (Optional Tools) on page 49.
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5 On the Autodesk 3ds Max or Autodesk 3ds Max Design Backburner tabs,
you can set the location for the install. To learn more about Autodesk
Backburner, see Autodesk Backburner 2008.1.1 on page 48.

Click Next to continue.

6 On the Autodesk 3ds Max or Autodesk 3ds Max Design Tutorials tabs,
you can set the location for the install.

7 When you have finished with all changes to the install settings for your
product click Configuration Complete.

8 Click Install to complete this customized installation.

NOTE The status bar indicates that the install is in progress, but does not
indicate the percentage of the install that has completed.

9 Click Finish to Exit the Installation Wizard.

NOTE If you want to install optional tools see Components (Optional Tools)
on page 49.
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Configure Button
During the installation process, you can choose to exclude some of the optional
components. To customize, you begin in the Review - Configure - Create
Deployments dialog box. Select the product you want to customize from the
drop-down list, and click Configure.

The following options are available after you click Configure. See Components
(Optional Tools) on page 49for more details about the components.

■ Select the Installation Type - Typical or Custom

■ Include Service Packs

When you finish selecting options for your customization, click the
Configuration Complete button. The Review - Configure - Create Deployments
dialog box is displayed again, and you can review your selections. Once you
have confirmed your selections, click Create Deployment.

NOTE To get a copy of your settings, select the Copy to Clipboard button.

mental ray Satellites
A port is selected by default for mental ray® network rendering. If the default
value does not suit your needs, you can change it to any numerical value
between 1 and 65535 but you should do so with caution. Speak with your
system administrator before assigning a new number. You can reset to the
default value by entering 0 in the port field.
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Interrupting the Install Process
You can interrupt the install process by clicking Cancel during the installation.
You then have the option of resuming the install or exiting. If you exit the
installation midway through, you can install the application at another time.
You will be prompted to click Finish to exit the Installation Wizard.

NOTE When you interrupt the install some items which were already installed are
removed. Therefore it may take some time before you can quit the Installation
Wizard entirely.

Leaving Ports Open
Autodesk 3ds Max or Autodesk 3ds Max Design, Autodesk Vault, Autodesk
Backburner, and various other components of the install, require that certain
ports be open in third-party firewalls. If you are having problems with your
firewall, read the documentation included with your firewall.
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Windows Theme Support
Autodesk 3ds Max or Autodesk 3ds Max Design can be customized to inherit
the Windows interface theme (this feature supports the Windows XP and XP
Classic themes as well as Windows Vista themes).

When you have chosen your preferred Windows theme, start your software
using your normal shortcut. Find information about customization options
under the topic, “Customize User Interface Dialog” in Help.

Starting Your Product
You can start your product using any of the following methods.

■ Desktop shortcut icon. When you install your product, a shortcut icon is
placed on your desktop unless you cleared that option during installation.
Double-click the icon to start your product.
The icons are different between 3ds Max and 3ds Max Design, as shown
below:

Autodesk 3ds Max
2010 icon

Autodesk 3ds Max
Design 2010 icon
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■ Start menu— On the Start menu, click All Programs (or Programs) >
Autodesk > Autodesk 3ds Max 2009 [32- or 64-bit] > Autodesk 3ds Max
2009 [32- or 64-bit].

■ Location where your product is installed— If you have administrative
permissions, you can run your product in the location where you installed
it. If you are a limited-rights user, you must run your product from the
Start menu or from the desktop shortcut icon. If you want to create a
custom shortcut, make sure that the Start In directory for the shortcut
points to a directory where you have write permissions.

Customer Involvement Program (CIP)
The first time you start Autodesk 3ds Max or Autodesk 3ds Max Design, the
Customer Involvement Program dialog opens. If you choose to participate in
the Customer Involvement Program, 3ds Max or 3ds Max Design will
automatically send Autodesk information about system configuration, what
features you use most, any problems that you encounter, and other information
helpful to the future direction of the product.
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Viewing the Essential Skills Movies
When you launch your product for the first time, the Essential Skills Movies
splash screen appears. You need Flash to view these movies. When you click
to view a movie, you will be prompted to install it if you have not already.

Watching the Movies from Autodesk.com
You can visit http://www.autodesk.com/3dsmax-essentials or
http://www.autodesk.com/3dsmaxdesign-essentials to view the same Essential
Skills Movies that are shipped with 3ds Max 2010 and 3ds Max Design 2010.
For information about the Procedural Movies, see Viewing the Procedural
Movies on page 49.
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Starting Your Product with Command Line Switches
You can start your product with special settings using command line switches.
To see a complete list of command-line switches and their functions, see
“Starting 3ds Max [Design] from the Command Line” in the Help.

NOTE You may need to activate the program before you can use these commands
to start it.

To run your product using a command-line switch:

1 Right-click the icon or its shortcut.

A shortcut menu appears.

2 Choose Properties.

The Properties dialog appears.

3 In the Target text box, add the command-line switch (in this example
-h) after the program path and executable file name. For example:

“C:\Program Files\Autodesk\3dsmax2010\3dsmax.exe” -h

NOTE Ensure the command-line switch is outside of the quotation marks
(“).

4 Click OK.

The command-line switch takes effect the next time you run the program
from the shortcut.

Registering and Activating Your Product
The first time you start your product, the Activation Wizard is displayed. You
can either activate your product at that time or run your product and activate
it later. Until you register and enter a valid activation code for your product,
you are operating the program in trial mode. The Register Today dialog is
displayed for 30 days from the first time that you run the program. If after 30
days of running your product in trial mode you have not registered and
provided a valid activation code, your only option is to register and activate
your product. Once you register and activate your product, the Register Today
dialog is no longer displayed.

The fastest and most reliable way to register and activate your product is by
using the Register Today dialog, which accesses the Internet. You enter your
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registration information and it is sent to Autodesk over the Internet. Once
you submit your information, registration and activation occur almost
instantly.

To register and activate your product

1 Start your product.

2 In the Activation Wizard, select Activate the Product, and then click Next.

This starts the Register Today process.

3 Click Register and Activate (Get an Activation Code).

28 | Chapter 2   Installing Your Product



4 Click Next and follow the on-screen instructions.

NOTE You will be prompted to Login to Autodesk. If you do not already
have an account, you will need to create one.

Offline Registration and Activation
If for some reason online registration and activation is not possible, you can
still register and activate your product offline. Your activation code is sent
back to you by email or fax.

E-mail Create an e-mail message with your registration information and send
it to Autodesk.

Fax Enter your registration information, and fax the information to Autodesk.

Phone Provide your registration information to one of our representatives
over the phone.
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Use the numbers or e-mail address that correspond to your area:

Fax and Phone Num-
bers

e-mailArea

FAX:authcodes@autodesk.comUnited States,
800.225.6490 orCanada
415.507.4937Latin America
Phone:
800.551.1490

Fax:authcodes.neu@autodesk.comEurope
+41 (32) 7239169Middle East

Africa

Fax: +65.6735.4857ap.register@autodesk.comAsia Pacific

Offline registration and activation is necessary under the following conditions:

■ An online request has timed out

■ A processing error occurred such as an invalid serial number

To register your product offline

1 If you are unable to register online, the Register Todays Connect to the
Internet page indicates the reason why online registration and activation
failed. Click the Use Another Method link.

2 On the Product Registration page, specify the following:

■ Whether the product will be registered to a company or individual.

■ The country or region where the product will be used.

■ Whether the product is an upgrade. If it is, you also need the previous
products serial number.

Click Next.

3 Enter your personalization data on the Customer Information page and
choose how you would like to receive your activation code - email, fax,
or postal mail. Click Next.

4 Review your personalization data on the Confirm Information page and
choose the method you will use to submit your request. Your request can
be sent by email, fax, or phone.
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If you choose Send My Request by Email, an email message will display
for you to complete. If you choose to forward your request by fax or
phone, the Contact Autodesk page will display with pertinent contact
information.

You will be sent your activation code by the method you specified on
the Customer Information page.

5 If you want to print a copy of your registration information, select the
Open Activation Request Form. When you are finished, click Close.

To activate an Autodesk product during launch

1 When you start the program, select Activate the Product in the [Autodesk
Product] Product Activation wizard, and click Next.

2 On the Activation page of Register Today, select Enter an Activation Code.

3 Select the method you would like to use for entering the activation code
you received from Autodesk.

■ Select Paste the Activation Code if you received your activation code
by email or electronic fax. Copy the code from the email and paste it
into the activation code field.

■ Select Type the Activation Code if you received your activation code
by postal mail or printed fax. Carefully enter the code, in groups of
four characters, into the numbered fields.

NOTE The code is not case sensitive and you may not need to use all 14
fields.

4 After entering the activation code, click Next.

5 On the Registration - Activation Confirmation page, click Finish.

To activate an Autodesk product from the Help menu

1 On the Help menu, click About.

2 In the About [Autodesk Product] window, click Product Information.

3 In the Product Information dialog box, click Activate.

4 In the [Autodesk Product] Product Activation wizard, select Activate the
Product, and then click Next.

5 On the Register Today page, follow the on-screen instructions.

Offline Registration and Activation | 31



Types of Licenses
When you purchase your product you purchase a license for a
standalone-licensed version, multi-seat standalone licensed version, or a
network-licensed version. The following section provides information on these
types of licenses.

■ For standalone and multi-seat standalone licenses also refer to the Autodesk
Stand-Alone Licensing Guide.

■ For network licenses also refer to the Autodesk Network Licensing Guide.

NOTE Access both guides on the Documentation page by clicking Read the
Documentation in the Installation Wizard of the Software DVD.

After activation, you can see which type of license you have for your product
by selecting Help > About > Product License Information.

NOTE If you are upgrading your product, you do not need the previous version
of your product installed on your system. However, you will need your previous
serial number to obtain a new activation code.

Standalone Licenses (Regular and Multi-Seat)
For a regular standalone license, when you activate your product, only the
computer you activated it on is licensed to run that copy of the program. The
license is bound to that machine.

For a multi-seat standalone license you use a single serial number for multiple
computers. The license is installed locally on each machine, and works for a
specific number of seats. The number of activations for the serial number is
tracked up to the maximum and then no additional sessions can be run.

In both cases, you license your product during the activation process as
described in Registering and Activating Your Product on page 27.

For complete information about standalone licenses, read the standalone
licensing sections along with the Autodesk Stand-Alone Licensing Guide available
on the Documentation page (bottom-left corner) in the Installation Wizard
of the software DVD.

32 | Chapter 2   Installing Your Product



Updating or Moving your License
Your stand-alone license allows you to run an Autodesk product on a single
computer. However, you can still install your Autodesk product on more than
one computer. Without purchasing a separate license for the second
installation, you can use the License Transfer utility to transfer a license from
one workstation to another.

For example, you sometimes find yourself working from both your office
desktop and an office laptop. Both computers have your Autodesk product
installed. Because most of your work is done on your office desktop, you
activated the license on that computer. If the trial period has expired on the
office laptop, you can use the License Transfer utility to transfer your license
from the office desktop to the office laptop. See Transfer a License on page
34 for more information.

If you make changes to your computer, or if you install your product on a
new computer, you need to take steps to ensure that you do not receive license
errors. You can use the License Transfer Utility to export the license from your
system. Changes that will require the use of the LTU include changing the
main hard disk, the motherboard, or upgrading the BIOS.

NOTE Just adding memory or changing the video card does not require
reactivation.

The license information is not removed when you uninstall the software
following a standard uninstall process. If you reinstall on the same system,
the license information is still valid. You do not have to reactivate or use the
LTU.

License Transfer Utility
With the License Transfer utility, you can use an Autodesk® product on more
than one computer without purchasing a separate license for each computer.
The License Transfer utility transfers a product license online from one
computer to another, and ensures that the product works only on the computer
that contains the license.

Introduction
Using the License Transfer utility, you can transfer an Autodesk product license
between computers. You may want to transfer a license to a computer
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temporarily (if you want to use an Autodesk product on your laptop, for
example) or permanently (if the computer where you originally activated your
Autodesk product is being replaced). You can leave the license on the secondary
computer indefinitely, or you can move the license between computers as
needed.

License transfers rely on a product’s serial number. Before an Autodesk product
can be exported, it must be activated with the serial number and product key.
During license import, a previously activated and exported license is imported
to a product or product suite installed with the same serial number. The
activation is transferred to the import computer, completing the license
transfer.

NOTE When you upgrade your Autodesk product (non-subscription), you can no
longer perform online license transfers of the previous license.

NOTE Although the License Transfer utility allows you to transfer your product
license between computers, your license agreement may not allow the installation
of an Autodesk product on more than one computer. Read your license agreement
to find out whether your product license permits the use of the License Transfer
utility.

Transfer a License
To transfer a license you must have an Internet connection, have an Autodesk
product installed on both computers, and perform an online export and import
of the license.

Install the Autodesk Product
Before you can use the License Transfer utility to transfer licenses, you must
have an Autodesk product installed on all computers involved in the transfer.
The License Transfer utility is a custom stand-alone installation option. During
installation, a shortcut is created from the Start (Windows) menu. A License
Transfer utility shortcut is installed once per product, per workstation.

To install the Autodesk product

1 Install and activate the Autodesk product on a computer.

See your product's installation instructions for complete details.
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2 Install the Autodesk product on any other computer that will be using
the License Transfer utility. You do not have to register or activate the
product on this computer.

See your product's installation instructions for complete details.

Export a License
A license is exported when the License Transfer utility moves a product license
from a computer to the online Autodesk server.

The license can be exported as public or private. Exporting a license as public
means that you are not reserving the license and anyone using the same serial
number and their own user ID and password can import that license. Exporting
a license as private means that you are reserving that license for yourself and
the license can only be imported with the same serial number, your user ID,
and your password.

NOTE An Internet connection is required to export a license.

To export a license

1 On the computer where you want to export the license, do one of the
following:

■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  [Autodesk
Product]  ➤  License Transfer Utility.

■ (Windows Vista) Click Start  ➤  All Programs  ➤  Autodesk  ➤ 

[Autodesk Product]  ➤  License Transfer Utility.

■ (Mac OS X or Linux) Double-click the License Transfer Utility shortcut.

The Export the License dialog box displays the Autodesk product name
and serial number.

2 In the Export the License dialog box, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Export page, confirm the export information.

5 If you want to make the license available as a public import, click Make
the license available as a public import.

6 Click Export.
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7 On the License Export Confirmation page, click Finish.

Import a License
A license is imported when the License Transfer utility moves a previously
exported product license from the online Autodesk server to a computer.

When you have exported a product license from a computer, you complete
the license transfer process by importing that license onto a computer. A
license is imported when the License Transfer utility creates an active license
on a computer, allowing your Autodesk product to run on this computer.

When you use the License Transfer utility to import a license to a computer,
you are not activating the product on the computer; you are simply transferring
your activation to this machine.

NOTE An Internet connection is required to import a license.

To import a license

 ➤ On the computer where you want to import the license, do one of the
following:

■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  [Autodesk
Product]  ➤  License Transfer Utility.

Converting a Standalone License to a Network License
A standalone license can be converted to a network-license. Check with your
Authorized Autodesk Reseller for more information. To locate your reseller go
to: http://www.autodesk.com/reseller.

Network Licenses
If you’ve purchased a network-licensed version of your product, network
administrators can perform a network installation by installing the Autodesk
License Manager tools. Refer to the Autodesk Network Licensing Guide available
on the Documentation page (bottom-left corner) in the Installation Wizard
of Software DVD.
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Network-licensed versions of your product obtain activation from a
network-license server.

Contact your Authorized Autodesk Reseller if you want to get a network license.
See http://www.autodesk.com/reseller.

License Borrowing
If you are running your product on a laptop, you can use the License Borrowing
Utility to check-out a license when you are not connected to the network. For
a complete explanation of license borrowing, see the Network Licensing Guide.
You can also refer to acad_brw.chm, installed in the \Program Files\Common
Files\Autodesk Shared\ENU folder on your local drive.

System Date and Time
In a network licensing setup the license server will not work if the system date
and time have been tampered with, either intentionally or by mistake. To fix
the problem set the clock back to the correct time and the license server will
be unlocked. You will need to buy a new license if your license has expired.
Permanent network licenses are not bound to a clock.

Graphic Cards and Drivers
For specifications for supported graphics cards, see Shared Hardware
Requirements (32- and 64-Bit) on page 8.

When you launch your product, the Direct3D (DirectX) graphics driver is
chosen by default. If you have DirectX 9.0c then DirectX 9.0 is selected. If
you have DirectX 10 (Vista only), then DirectX 10 is selected. You can try the
different drivers if you are not sure which option gives you the best
performance. Choose Windows Start > Programs > Autodesk > Autodesk 3ds
Max and Autodesk 3ds Max Design > Change Graphics Mode.
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When you find a driver that gives you the best performance, start your software
using your normal shortcut. Find information about all the driver options in
“Graphics Driver Setup Dialog” in the Help.

Checking for Graphics Card Updates
It is recommended that you verify and update your graphics card driver if a
a new version is available. Doing so can improve system stability and
performance while using 3ds Max or 3ds Max Design. Use the following
procedure to identify your current graphics card driver.

To check if new drivers are available (Windows XP, not Vista)

1 On the Start menu, click Settings > Control Panel.

2 Click the Display icon to access the Display Properties.

3 Open the Settings tab and click the Advanced button.

4 Click the Adapter tab to check the adapter type.

5 Click the Properties button and open the Driver tab to check driver version
and see if newer drivers are available.
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To check if new drivers are available (Windows Vista, Classic View)

1 On the Start menu click Control Panel.

2 Click Personalize.

3 Open Display Settings and click Advanced Settings.

4 Click the Adapter tab to check the adapter type.

5 Click the Properties button and open the Driver tab to check driver version
and see if newer drivers are available.
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NOTE Graphics driver information is also viewable within 3ds Max or 3ds Max
Design from Customize menu > Preferences > Preference Settings dialog >
Viewports tab.

TIP Many newer graphic cards offer tabbed pages where you can learn more
precise information about your specific graphic card. If specific tab pages are
present, refer to them instead of the Adapter tab.

Troubleshooting Graphics Card Issues
If you run into any issues related to your graphics card during start-up, it is
recommended that you confirm that you have the correct DirectX drivers (see
System Requirements on page 6) and also refer the Video Driver and Display
Problems topic in the Help file (3dsmax.chm). You can access this file by
navigating to \\Program Files\Autodesk\3ds Max 2010\help. This topic will
help you resolve most graphics card issues.

Reinstalling or Repairing Your Product Install
If you accidentally delete or alter files that are required by your product, you
may receive error messages when you try to execute a command or find a file.
You can usually fix the problem by reinstalling or repairing your product. The
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reinstallation or repair uses the features that were part of the installation type
you chose when you initially installed the program. You may need the Software
DVD for reinstallation and repair.

NOTE The procedures differ between Vista and other Windows operating systems.

NOTE When repairing your product, make sure that you have exited the program
and make sure it is not running in a minimized state. If an existing file is newer
than a file normally used to repair it, the existing file isn’t changed. In other words,
if you’ve applied a patch, a repair will not restore the system to a pre-patched
state.

To reinstall or repair your product (Windows XP, not Vista)

1 Select Start menu > Control Panel > Add or Remove Programs.

2 In the Add or Remove Programs window, select either Autodesk 3ds Max
2010 or Autodesk 3ds Max Design 2010.

You can also reinstall or repair the other components of your product
install using the same procedure. Select the corresponding item from the
Add/Remove Programs list.

The Installation Wizard re-opens in Maintenance Mode.
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3 On the Application Maintenance page, click one of the following, and
then click Next:

■ Repair—This option replaces all registry entries that 3ds Max or 3ds
Max Design initially installed and restores 3ds Max or 3ds Max Design
to its default state. If you are missing 3ds Max or 3ds Max Design files,
use this option.

■ Reinstall—This option repairs the registry and reinstalls all files from
the original installation. Use this option if the Repair My Installation
option does not solve the problem.

NOTE It is not necessary to use the Modify option. The only thing you can
modify separately is the desktop shortcut.

4 Click Next to start the process.

On the Repair Complete page, you are informed when the repairs have
been performed.

5 Click Finish.

To reinstall or repair Autodesk 3ds Max or Autodesk 3ds Max Design
(Windows Vista, Classic View)

1 Select Start menu > Control Panel > Program and Features
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2 In the Uninstall or Change Program window, select Autodesk 3ds Max
2010 or Autodesk 3ds Max Design 2010.

You can also select other components using the same procedure. Select
the corresponding item from the list.

The Installation Wizard re-opens in Maintenance Mode.

3 Click Change or Repair:

■ Repair—This option replaces all registry entries that 3ds Max or 3dds
Max Design initially installed and restores 3ds Max or 3ds Max Design
to its default state. If you are missing 3ds Max or 3ds Max Design files,
use this option.

■ Change— You can use this option to uninstall if you want to see the
progress of the uninstall.

4 Click Next to start the process.

On the Repair Complete page, you are informed when the repairs have
been performed.

5 Click Finish.
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Uninstalling Your Product
Uninstall your product using Add/Remove Programs (Uninstall or Change
Program in Vista). Several components are separate installs. You need to
remove each component separately.

NOTE Certain files are left on your system after you uninstall your product. For
information on removing these files, refer to the Readme available on the
Documentation page (bottom-left corner) in the Installation Wizard of Software
DVD.

To uninstall 3ds Max or 3ds Max Design (Windows XP, not Vista)

1 Select Start menu > Settings > Control Panel > Add or Remove Programs.

2 In the Add or Remove Programs window, select the item that you want
to remove, and then click Remove.

NOTE If you remove the FBX Plug-in a separate window will open and you
will need to click Uninstall. When the uninstall is complete, click Close.

3 When informed that the component has been successfully uninstalled,
click Finish.
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4 Repeat with any other components that you want to remove.

NOTE Even though 3ds Max or 3ds Max Design is removed from your system,
the software license remains. If you reinstall your product at some future time,
you will not have to register and re-activate the program.

To uninstall your product (Windows Vista, Classic View)

1 Select Start menu > Control Panel > Program and Features

2 In the Uninstall or Change Program window, select Autodesk 3ds Max
2010 or Autodesk 3ds Max Design 2010.

You can also select other components of your product install using the
same procedure. Select the corresponding item from the list.

The Installation Wizard re-opens in Maintenance Mode.

3 Click Uninstall.

4 Follow the prompts.

5 Click Finish.
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Supplemental Tools and
Utilities

You can install many supplemental tools and utilities from the Installation Wizard. Some of
these tools and utilities are required while others are optional. This chapter describes each of
the supplementary tools, including how they are installed.

Required Tools and Utilities
Autodesk Backburner 2008.1.1, .NET, and Direct X 9.0c and 10 updates are
installed by default during the 3ds Max or 3ds Max Design installation.

If you have already installed the required version of any of these tools or utilities,
they will not be selected for install. If you have installed an older version of
Autodesk Backburner you will be prompted to uninstall it before continuing.
Also see Network Licensing Tools (Required for Network Licensing) on page 52.

DirectX 9.0c and 10
For DirectX 9.0c you must at least have the original version of DirectX 9.0c
from Microsoft. If you have Windows XP SP2, you should already have it
installed.

For DirectX 10 you must have DirectX 10 and all of the updates from Microsoft.
If you are running Windows Vista, you should already have these items installed.

You can download the latest version of DirectX (for DirectX 9.0c or 10) from
http://www.microsoft.com/DirectX. Choose either the For Gamers or For Pros link
and then click Download the Latest DirectX.

When you install Autodesk 3ds Max, a specific set of Direct 3D updates is
installed for DirectX 9.0c (June 2007, December 2006, and October 2006) and
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for DirectX 10 (June 2007 and December 2006). These updates make it possible
for DirectX to work with Autodesk 3ds Max.

Autodesk Backburner 2008.1.1
Autodesk® Backburner™ is the 3ds Max and 3ds Max Design network-rendering
management software, also used by products such as Autodesk®  Combustion®,
Autodesk® VIZ® , Autodesk®  Flame® , and Autodesk® Smoke®. It is installed
during the installation of 3ds Max or 3ds Max Design.

If you're installing 3ds Max or 3ds Max Design on a system that had
installations of Autodesk VIZ 2006, 2007, and 2008, Autodesk 3ds Max 8, 9,
or 2008 or Autodesk Combustion, an older version of Autodesk Backburner
is already installed on the system. You should uninstall previous versions of
Autodesk Backburner before installing the new version. Autodesk Backburner
2008.1.1 is installed by default to the following path: \Program
Files\Autodesk\Backburner. Autodesk Backburner 2008.1.1 is backward
compatible so reassigning older jobs to it is not a problem.

For information on using Autodesk Backburner with 3ds Max or 3ds Max
Design see the “Network Rendering” section of the Help. For further
information about Autodesk Backburner refer to the Autodesk Backburner User’s
Guide and Autodesk Backburner Installation Guide which are available from Start
> Programs > Autodesk > Autodesk 3ds Max 2010 [32- or 64-bit] > Help.

NOTE Autodesk Backburner 2008.1.1 does not acquire settings from previous
versions of Autodesk Backburner. You must create new settings in Autodesk
Backburner 2008.1.1.

Autodesk Backburner 2008.1.1 for Managing and
Monitoring Only
You can install Autodesk Backburner 2008.1.1 on a machine without 3ds Max,
3ds Max Design, or another supported product such as Autodesk VIZ or
Autodesk Combustion. However, such an installation of Autodesk Backburner
cannot be used for rendering. You can only use this machine to manage or
monitor jobs. Although the Autodesk Backburner server can be installed on
a single machine, it will not do anything; it will only work if it detects a
supported program such as Autodesk 3ds Max, Autodesk 3ds Max Design,
Autodesk VIZ, or Autodesk Combustion. This means that you must have
Autodesk Backburner installed with at least one additional Autodesk product
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for a machine to render in your configuration. See Installing Autodesk
Backburner 2008.1.1 for Managing and Monitoring Only on page 56.

Components (Optional Tools)
The following are the optional Autodesk tools that can be included when
installing 3ds Max and 3ds Max Design.

Architectural Materials, ProMaterials, and Additional
Maps and Materials

By default the Architectural Materials, ProMaterials, and Additional Maps and
Materials options are installed. These include several maps and materials which
are installed into your \3ds Max 2010\maps (including \3ds Max
2010\maps\ProMaterials) and 3ds Max 2010\materiallibraries folders. Refer to
the Help for information on maps and materials.

Viewing the Procedural Movies
There are several Procedural Movies included with your product. Throughout
your product Help you will find links to these movies indicated by the filmstrip
graphic. You can also search for the words "watch a movie" in the help file.
For the movies to load when you click the links in the Help, you need to install
this Movie item (which is selected for install by default when you install 3ds
Max or 3ds Max Design). These movies demonstrate common procedures
performed in 3ds Max and 3ds Max Design. For information about the Essential
Skills Movies, see Viewing the Essential Skills Movies on page 26.

Autodesk Vault 2009 and 2010 Plug-Ins (32- or 64-bit)
The Autodesk Vault 2009 and 2010 Plug-ins are installed by default when you
install Autodesk 3ds Max 2010 or Autodesk 3ds Max Design 2010. These
Plug-ins are used to communicate with the Autodesk Data Management Server.
The Autodesk Data Management Server and Autodesk Vault Explorer are
available to subscription customers on the subscription web site
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(http://www.autodesk.com/3dsmax-subscription). Login to the Subscription Center
and then scroll down to the “Product Information and Downloads” section
and click on the Click Here link under “Autodesk Vault.” On the next page
select either 3ds Max 2010 or 3ds Max Design 2010 and follow the instructions.

Additionally the Autodesk Data Management Server and Autodesk Vault
Explorer are shipped with certain other Autodesk products. If you have the
Autodesk Data Management Server and Autodesk Vault Explorer from any of
these sources then you will need the Plug-in of the same version. Find the
Autodesk Vault 2009 and Autodesk Vault 2010 Plug-ins on the Software DVD.
By default, the plug-ins are selected for install when you install 3ds Max or
3ds Max Design. If you do not have the Autodesk Data Management Server
and Autodesk Vault Explorer, then you do not need to install the Vault
Plug-ins.

If you are unsure about your Autodesk Vault version, in the Help menu of
Autodesk Vault Explorer, click About Autodesk Vault Explorer. See
http://www.autodesk.com/vault for a complete description of Autodesk Vault.

Installing Plugins
The following are the optional Autodesk and 3rd party plugins that can be
used with 3ds Max and 3ds Max Design. These tools can be installed from the
Install Tools and Utilities section of the installer.

TurboSquid Tentacles (32- or 64-bit)
TurboSquid™ Tentacles is free software you can use to buy and sell digital
assets. It provides access to a strong community of graphics professionals and
a growing library of over 70,000 models, motion capture files, maps, sounds,
plug-ins and more. For more information, visit the TurboSquid Web site at
http://www.turbosquid.com. It is installed by default during the installation of
your product.
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Autodesk Design Review 2009
You use Autodesk Design Review 2009 to view and print 2D and 3D designs
in the DWF file format. Refer to the “Exporting 3D DWF Files” topic in the
Help for information about using Autodesk Design Review with 3ds Max and
3ds Max Design. For further information about Autodesk Design Review see
http://www.autodesk.com/designreview.

Autodesk 3ds Max 2010 SDK
Information about the Autodesk 3ds Max Software Development Kit (SDK) is
available on our peer-to-peer SDK Forum on the World Wide Web. To visit
the SDK Forum, use the Autodesk Media and Entertainment Online Forum
Web site at: http://www.autodesk.com/3dsmax-sparks.

NOTE The SDK is not shipped with Autodesk 3ds Max Design 2010.

To install the Autodesk 3ds Max 2010 SDK Help and/or the Max SDK Help for
Visual Studio 2005 follow the instructions for Installing Optional Tools on
page 56.
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Autodesk 3ds Max 2010 SDK Help
If you install the Autodesk 3ds Max 2010 SDK Help, it is installed in CHM
format in the \maxsdk\help folder under \3ds Max 2010.

You can use the SDK to create new Autodesk 3ds Max features and tools by
writing your own plug-ins.

Autodesk 3ds Max 2010 SDK Help for Visual Studio
2008 SP1
A version of the SDK help has been created that is integrated into the
Microsoft® Visual Studio® environment if you install Autodesk 3ds Max 2010
SDK Help for Visual Studio. You should not select this option for install if you
do not have Visual Studio installed.

To view the Autodesk 3ds Max 2010 SDK Help from inside Visual Studio:

1 Launch Visual Studio.

2 Show the Contents panel.

Notice a new entry on the Contents panel called: 3ds Max 2010 SDK
Help.

3 Expand the 3ds Max 2010 SDK Help entry to view the associated help.

NOTE You can also select the 3ds Max SDK filter using the Filtered By list in
Visual Studio to use the Table of Contents, Index, and Search for the entire
3ds Max SDK help collection.

Network Licensing Tools (Required for Network
Licensing)

In a network licensing setup the network administrator needs to install the
Network Licensing Manager before registering the license online.
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Find full details on network licensing in the Network Licensing Guide
(adsk_nlg.pdf) available on the Documentation page (bottom-left corner) in
the Installation Wizard of Software DVD.

■ Network Licensing Manager—The Network License Manager is used to
configure and manage license servers.

■ Network License Activation—To register and activate a network license,
you need to go online and use your Autodesk User Account (you can create
one if you don’t have one yet) to submit your product information at
https://registeronce.autodesk.com. In addition, you can register your
product, get automated support by e-mail, and save and migrate license
files automatically.

SAMReport-Lite
SAMReport-lite is a reporting tool that helps you track network license usage.
You need to obtain a separate license for this tool. Click the Obtain a License
link below the SAMReport-lite entry in the Select the Products to Install page
of the Installation Wizard. Refer to the Autodesk SAMReport-lite User's Guide
available from the Documentation page (bottom-left corner) in the Installation
Wizard of Software DVD.

Partners/Plug-Ins
3ds Max and 3ds Max Design include several partner plug-ins.

WARNING You need to install and run at least once either 3ds Max 2010 or 3ds
Max Design 2010 before installing these plug-ins. This will improve the
compatibility of the plug-ins with 3ds Max or 3ds Max Design.

■ RPC™ Plug-Ins from ArchVision™, Inc. and Sample Content (32- or 64-bit)—
Lets you add photorealistic objects (such as cars, people, etc.) from the
included ArchVision sample CD to your renderings.
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■ EASYnat™ from Bionatics® s.a.—Offers a lifelike plant modeling solution
that allows you to drop virtual seeds from the included samples and “grow”
them in your model. Create 2D, 3D, and hybrid models that include branch
and leaf detail.

■ Okino PolyTrans™ and NuGraf™ Demos (32- or 64-bit)— A demo version
of PolyTrans and NuGraf, from Okino Computer Graphics, lets you evaluate
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dozens of CAD, DCC and VisSim data converters directly within 3ds Max
or 3ds Max Design.

NOTE You need to also install the Okino Plug-ins Demo to access PolyTrans
and NuGraf from inside 3ds Max or 3ds Max Design.

■ Okino PolyTrans™ Plug-ins (32- or 64-bit)— Makes it possible for you to
access the PolyTrans and NuGraf plug-ins from inside 3ds Max or 3ds Max
Design.

■ TurboSquid™ Tentacles from TurboSquid— See TurboSquid Tentacles (32-
or 64-bit) on page 50.

■ Flight Studio 2009 Plug-in See Flight Studio 2009 Plug-in (32- or 64-bit)

JRE 1.4.2 (Java™ Runtime Environment)
You will need this download to use the JSR Viewer (M3G Player) which you
access from Programs > Autodesk > Autodesk 3ds Max 2010> JSR Viewer. A
link to the installer is available on the “Select the Products to Install” in the
Install Tools and Utilities section of the installer.
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Adobe® Flash® Player 10
You need Flash to view the Essential Skills Movies and the Procedural Movies.
If you try to view a movie without it installed, you will be prompted to install
it. A link to the installer is available on the “Select the Products to Install” in
the Install Tools and Utilities section of the installer

NOTE You can also view the Essential Skills Movies at
http://www.autodesk.com/3dsmax-essentials or
http://www.autodesk.com/3dsmaxdesign-essentials.

Installing Autodesk Backburner 2008.1.1 for
Managing and Monitoring Only

You can also install Autodesk Backburner 2008.1.1 for managing and
monitoring only.

To install required tools without 3ds Max or 3ds Max Design:

1 On the Software DVD navigate to the \support\backburner folder.

2 Double-click backburner.exe.

3 Follow the prompts to complete the Backburner install.

Installing Optional Tools
This procedure covers installing the optional tools from the Tools and Utilities
section of the Installation Wizard. For information on installing the Samples
and Tutorial Scene Files. See Installing Samples and Tutorial Scene Files. Certain
optional tools are installed from the Install Products section of the Installation
Wizard. See Installing Your Product on page 16.

1 Insert the Software DVD.

NOTE  If Autorun does not start the Installation Wizard, navigate to your
DVD-ROM. Click the Setup.exe file to open the Installation Wizard.

2 In the Installation Wizard, click Install Tools And Utilities.
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3 Choose the products you want to install on the Select the Products to
Install page. Click Next.

NOTE For Java and Flash Player only web links are provided. You need to
visit the corresponding web site to install them.

WARNING Before installing the plug-ins you need to install 3ds Max 2010
or 3ds Max Design 2010 and open it at least once. This will ensure that the
plug-ins fully detect 3ds Max or 3ds Max Design.

4 On the Review - Configure - Install page, click Install if you want to accept
the default install location.

If you want the tool or utility installed in a different installation path,
click Configure, set the path and then click Configuration Complete and
then Install.

5 Depending on the products you choose, separate install dialogs will
prompt you for ArchVision, RPC, EASYnat, and Okino PolyTrans and
NuGraf. For ArchVision you will also need to set the content management
path.

6 Click Finish when the Installation Complete page is displayed.
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Installing Tutorial Scene Files and Samples
The tutorials can be found in the Help files for either 3ds Max or 3ds Max
Design. As you work through these, you will need various tutorial scene files.
If you did not select to install the tutorial files with the software, you can
install them separately.

To install the tutorial scene files separately from 3ds Max or 3ds Max Design:

1 Insert the Software DVD.

NOTE  If Autorun does not start the Installation Wizard, navigate to your
DVD-ROM. Click the Setup.exe file to open the Installation Wizard.

2 Click Install Products on the Main Menu.

NOTE Click Read the Documentation if you want to access the install
documentation set.

3 On the Select Products to Install page, select Tutorial Files.

Click Next to continue.
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4 On the Product and User Information page enter your details.

NOTE Be precise because you will not be able to change this information
once you begin the install, unless you uninstall and reinstall 3ds Max or 3ds
Max Design.

5 On the Review - Configure - Install page you can change the location of
where the tutorial files will be installed. Click Configure to change the
location, or Click Install to copy the files to the default location.

Samples
The total collection of sample files is quite large. You can manually copy them
to your hard drive from the Sample Files DVD. The samples include maps and
material library files. Sample files have their file attributes set to Read-only by
default. Attempting to save a sample file using the same name will result in
an error unless you turn the Read-only property off, so that the file becomes
writeable.

Autodesk Product Trials
Try out the features of these industry-standard Autodesk tools that can help
you visualize a concept and create content across any media or platform.
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Autodesk® ImageModeler™

Use ImageModeler for image-based modeling and photogrammetry to generate
3D models from photographs—giving architects, designers, and entertainment
content creators a new approach to 3D modeling. Bridging the 2D and 3D
worlds, ImageModeler enables you to capture reality as-built and integrate
photorealistic 3D models into your 3ds Max workflow.

Autodesk® MotionBuilder®

Whether you’re working on a 30-second commercial, or on a large game or
film project, adding Autodesk MotionBuilder software brings significant
productivity and speed gains when dealing with the complexity of 3D character
animation. With its real-time, non-linear environment, cutting-edge rigging
and simulation features, and powerful tools for handling motion-captured
data, it’s the perfect complement to 3ds Max. Thanks to its native support for
the platform independent FBX 3D authoring and interchange format, you
can also benefit from seamless data exchange with 3ds Max and a host of
other 3D packages.
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Autodesk® Mudbox™

Designed by professional artists in the film, games, and design industries,
Autodesk Mudbox digital sculpting and texture painting software combines
a highly intuitive user interface with a powerful creative toolset for creating
ultra-realistic high-poly 3D models. Mudbox provides an organic brush-based
3D modeling experience that complements the new 3ds Max 2010 Graphite
modeling tools.

Autodesk® Stitcher™ Unlimited
Autodesk Stitcher Unlimited photo merging software offers 3ds Max users
easy-to-use tools for creating high-quality panoramas, wide-angle images,
virtual tours and matte paintings. Stitcher Unlimited can also create HRD
images for global illumination and image-based lighting.

Autodesk® Toxik™

Autodesk Toxik is a node-based compositing solution with advanced image
processing capabilities, designed with the creative user in mind. The software’s
architecture is built around its Ultra-High Resolution Interaction and High
Dynamic Range Imagery (HDRI) core, which allows compositing professionals
to work interactively and intuitively with virtually any visual media, regardless
of bit-depth or image size. Toxik also features: Reaction, Autodesk's
next-generation 3D environment for interactive compositing; Suave, a
high-quality software renderer; and Touch UI, a unique gestural user interface
paradigm. With its intuitive toolsets, open architecture and high level of
interoperability with Autodesk 3ds Max, Toxik is the compositor of choice for
everyone from independent 2D visual effects artists and design visualization
specialists to large-scale film and broadcast facilities.

Installing an Autodesk Product Trial
This procedure covers installing trial versions of other Autodesk products that
can be used in the same work pipeline with 3ds Max and 3ds Max Design.
These Autodesk trials can be found in the Tools and Utilities section of the
Installation Wizard.

1 Insert the Software DVD.
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NOTE  If Autorun does not start the Installation Wizard, navigate to your
DVD-ROM. Click the Setup.exe file to open the Installation Wizard.

2 In the Installation Wizard, click Install Tools And Utilities.

3 Choose the products you want to install on the Select the Products to
Install page. Click Next.

4 On the Begin Installation page, click Install.
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Installation
Troubleshooting

If you have any problems when using your product the following frequently asked questions
may help you find a solution. You may also find solutions to your problems on the Autodesk
Web Support page for Autodesk 3ds Max or Autodesk 3ds Max Design. See
http://support.autodesk.com and select Autodesk 3ds Max or Autodesk 3ds Max Design. Enter
keywords describing your question in the Search field.

Graphics Card Issues
See Graphic Cards and Drivers on page 37.

Compatibility of 3ds Max 2010 with 3ds Max Design
2010

You can install Autodesk 3ds Max and Autodesk 3ds Max Design on the same
machine. Files that you create in on application can be opened in the other.

NOTE Exposure™ Daylight Simulation and Analysis Technology is only available in
3ds Max Design 2010 so you will not be able to adjust these settings in 3ds Max
2010.

4
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Other File Issues

Backward Compatibility of Files
Files saved in the MAX format are forward compatible. You can try File >
Export from Autodesk 3ds Max and use File > Import in an earlier version of
your product, but some data may be lost.

Opening VIZ Files in 3ds Max 2010 or 3ds Max Design
2010

VIZ, 3ds Max, and 3ds Max Design all use the MAX file format so you can
share files. Certain VIZ features do not work in 3ds Max or 3ds Max Design.
“Stand-in” objects may be used to replace features which are not supported
in 3ds Max or 3ds Max Design.

Opening or Linking to an Autodesk Architectural
Desktop Drawing or Model

When you open or link to an Autodesk® Architectural Desktop drawing or
model, certain objects may not show up. The most likely cause is that you are
missing the Architectural Desktop object enablers. AutoCAD 2010 and
AutoCAD vertical applications, such as Architectural Desktop (ADT), have
custom objects that are unique to the product. In order to view them in 3ds
Max or 3ds Max Design, you need the appropriate object enabler (OE). Object
enablers let you access, display, and manipulate these objects in AutoCAD
2010, and also the other vertical applications, including 3ds Max and 3ds Max
Design. For a list of downloadable Object Enablers, see
http://www.autodesk.com/autocad-object-enablers.

Licensing and Activation Issues
This section outlines common issues and their solutions with regards to
software licenses and the licensing of your product(s). Also see License Transfer
Utility.
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Sharing Your License between Business and Home
(Subscription Only)

If you are a 3ds Max or 3ds Max Design subscription customer you can use
your license for both business and home use. The complete instructions for
doing so are found at our subscription site at:
http://pointa.autodesk.com/local/enu/portal/vip/members/index.jsp?po=enu#. Click
Request Home Use under Subscription Administration.

NOTE You need a subscription login to access this page.

License Errors
If you receive a license error, you will need to reactivate your copy of your
product. You can use the Activation Wizard to complete your request.
Depending on the error, you may have a seven-day grace period, from the
time of your license error, before you must reactivate your product. After the
seven-day grace period, you will not be able to use the software again until
you have entered a new activation code. In certain cases, there is no grace
period.

If a new activation code is needed, the Activation Code dialog will appear
when you start your product. You can only choose to activate the product if
you encounter a licensing error.

Exporting Your License to Another PC
The first time you export to another PC, you have to write the file (and it can
be anywhere, on a floppy, or shared network drive). But after that, you can
use the Transfer Code instead. Export normally, but instead of entering a file
name, on the Export Type Selection dialog, choose the Transfer Code option.
Write down the code and click Transfer. On the other PC, choose Transfer
Code again on the Import page, and enter the code.

NOTE Transfer codes can't be reused; you'll get a new one each time.

Lost Exported License
On the PC where you last worked, run the LTU (see License Transfer Utility)
and export the license again. Then make a new floppy. This works because it
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remembers which PC you exported it to. You can only re-export to the same
PC.

Lost Exported License with Hard Disk Failure
Contact the Autodesk registration center directly by phone, fax, e-mail, or
online. A technician will help you re-initiate your product license. See
Registering and Activating Your Product on page 27.

Major System Failure without Parking the License
If the hard drive is damaged beyond recovery, it is unlikely the license will be
retrievable. You will have to resubmit to get a new activation code after the
operating system is reloaded. See Registering and Activating Your Product on
page 27.

Activating During Non-Business Hours
3ds Max and 3ds Max Design both include an electronic registration and
activation feature that allows users (in some geographic locations) to obtain
an activation code at any time. You can only attempt to activate your product
a certain number of times before you will need to contact a authorization
code representative to assist you with your activation. See Registering and
Activating Your Product on page 27.

Reactivating Your Product
The activation code is unique in every instance and cannot be used more than
once.

Reactivating Partner Applications when Reactivating
Your Product

Once activated, partner applications shouldn’t need reactivation. If, for some
reason, you need to reactivate your license for 3ds Max or 3ds Max Design,
partner applications will operate correctly once 3ds Max or 3ds Max Design
is running again.
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Networking Issues
This section outlines common issues and their solutions with regards to
performing a network installation or configuring your network license server(s).

Locating Your Server Name
When installing a network licensed product, you must specify the name of
the server that will run the Network License Manager. If you don’t know the
server name, you can quickly find it by opening a Windows command prompt
on the system that will be the Network License Manager. At the prompt, enter
ipconfig /all and note the Host Name entry.

Log Files
There are two types of log files that can be generated that monitor information
about deployments and installations.

The Network log file keeps a record of all workstations that run the
deployment. The log lists the user name, workstation name, and the status of
the installation. Refer to this file for status information and details about
problems that users may have encountered during installation.

The Client log file contains detailed installation information for each
workstation. This information may be useful in diagnosing installation
problems. The client log is located in the \Temp directory of each client
workstation.

Creating Custom Desktop Shortcuts
You can choose to create custom desktop shortcuts that use command line
switches to specify several options when you start the program. For example,
command line switches can be set to run a script during program launch,
create a drawing based on a template or prototype drawing, or designate a
workspace that should be restored on startup.

To create a custom desktop shortcut:

1 Right-click your Autodesk 3ds Max 2010 or Autodesk 3ds Max Design
2010 icon on the desktop.
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2 On the Shortcut Tab, in the Target box, add your switch after the
quotation marks. For example:

"C:\Program Files\Autodesk\3ds Max 2010\3dsmax.exe" -q

NOTE For setups with a 64-bit operating system and 32-bit version of 3ds
Max or 3ds Max Design you need to use this switch instead:

"C:\Program Files (x86)\Autodesk\3ds Max 2010\3dsmax.exe" -q

3 Click Apply.

When you use this desktop shortcut, your switch will be applied. In this
example, 3ds Max or 3ds Max Design will start without the splash screen
showing.

NOTE There are several other switches you can use following this procedure.
For a list see “Starting 3ds Max from the Command Line.”

Uninstall and Maintenance Issues
This section describes common issues and their solutions resulting from adding
and removing features, reinstalling or repairing your installation, and
uninstalling products.

Installation Location
After your product is installed, you cannot change the installation path from
the Add/Remove Features page. Changing the path while adding features
would result in program corruption.

Files Remaining After an Uninstall
If you uninstall the product, some files will remain on your system such as
files you’ve created or edited, like drawings or custom menus.

Your license file also stays on your workstation when you uninstall your
product. If you reinstall on the same workstation, the license information
remains valid and you do not have to reactivate the product.
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For complete details on removing all remaining files, refer to the Readme
available on the Documentation page (bottom-left corner) in the Installation
Wizard of Software DVD.

General Installation Issues
This section outlines common issues and their solutions that may arise while
performing a general install of your product(s).

Installing Your Product on a Drive Besides C
By default, your product will install to the drive containing the Program Files
folder. If that drive happens to be c:, then the Installation Wizard assumes
you want to install to a folder named c:\Program Files\Autodesk\3ds Max 2010
(or c:\Program Files (x86)\Autodesk\3ds Max 2010 for the 32-bit version of 3ds
Max or 3ds Max Design running on a 64-bit machine.) If the installer detects
that you do not have sufficient space on the drive, a dialog will pop up asking
you to change the path to a drive which has sufficient space.

If you choose to change the drive location, be sure to specify the entire path
of the location where you want to install your product. If you simply type c:,
you run the risk of installing the program into your system’s root folder.

Checking DirectX Version
If your graphics card supports DirectX and you have drivers loaded, you can
run a utility that loads with the DirectX drivers. From the Windows Start
menu choose Run. In the Open field, type dxdiag.exe. This utility will display
a dialog showing you which version of DirectX is currently installed.

Finding Latest Service Packs
To find out if a patch or Service Pack is available for your product, visit the
Autodesk Product Support page at http://support.autodesk.com/.

Communication Center
See “Communication Center” in the Help.
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InfoCenter
See “InfoCenter” in the Help.

General Error Messages
The following are some solutions to specific error messages:

‘Error: “Interactive 3D Renderer initialization failed. Please check your device
settings by using the –H command line option.”’

This error indicates that the video setting is incorrect. To fix this see Graphic
Cards and Drivers on page 37.

‘Error: “TCP/IP error or Transport error – The network protocol TCP/IP is not
configured properly.”’

This error indicates an issue with your computer's network configuration.
Refer to the documentation included with Autodesk Backburner which you
can access from Start > Programs > Autodesk > Autodesk 3ds Max 2010 [32-
or 64-bit] > Help.
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